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Práctica 1

COMPONENTES
ELECTRÓNICOS PASIVOS.

CONSEJOS Y OBLIGACIONES GENERALES.

1. IMPORTANTE: ES OBLIGATORIO LA PRESENTACIÓN DE TODOS
LOS RESULTADOS TEÓRICOS Y DE SPICE Y LA RESPUESTA
A TODAS LAS PREGUNTAS PARA PODER REALIZAR LAS
SESIONES DE LABORATORIO.

2. Los montajes prácticos se deberán traer montados a la sesión de
laboratorio. Se recominenda a los estudiantes que dispongan de su propia
placa de montaje de circuitos pues les será de utilidad en toda la
Ingenieŕıa, aśı como que adquieran sus propios componentes. Con esto
se pretende que el estudiante sea capaz de enfrentarse a los proveedores
de material electrónico.

1.1. MANEJO DE INSTRUMENTOS

OBJETIVO. Familiarizarse con los instrumentos que se utilizarán en las prácticas de
las asignaturas de Ingenieŕıa Electrónica: generador de señales, fuente de alimentación,
osciloscopio, mult́ımetro y zócalo de montaje de circuitos. Familiarizarse con herramientas
anaĺıticas y de simulación (SPICE) de análisis temporal de circuitos electrónicos
(comportamiento ac, transitorios).

MONTAJE 1. Considérese el circuito de la figura 1.1. La señal de entrada de este
circuito, Vi(t), se muestra también en dicha figura, tal y como se veŕıa en la pantalla del
osciloscopio.

1. Trabajo teórico: Expresar en forma de función matemática la señal que se
representa en la figura 1.1. Representar junto a la señal de entrada la señal que
se obtendŕıa a la salida, Vo(t), indicando claramente los valores de la amplitud, el
desfase respecto a la señal Vi(t) y el valor medio.

2. Trabajo de Spice: Realizar en Schematics un circuito equivalente al de la figura
1.1, nombrando los nodos de entrada y salida como Vi y Vo, respectivamente.
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Figura 1.1: R1 = 10KΩ ,R2 = 16KΩ, C = 2.2nF

Utilizar como fuente de entrada VSIN proporcionándole los valores apropiados
de DC, AC, VOFF, VAMPL, FREQ.

Activaremos el análisis transitorio para realizar un análisis de la evolución
temporal desde 0 hasta 5 ms, tomando muestras cada 10µs (“Step Ceiling”).
Es muy importante ajustar convenientemente este parámetro en función de
las frecuencias implicadas en el circuito para poder visualizar correctamente
los resultados del análisis transitorio. Obtener resultados marcando la casilla
Skip initial transient solution. Repetir la simulación con la casilla sin marcar.
Comentar a qué se debe la diferencia. ¿Cuál es la excitación real de la entrada
en ambas situaciones?

Representar en la misma gráfica las señales Vi(t) y Vo(t) durante 5 ms y
comparar los resultados con lo obtenido teóricamente.

3. Trabajo de laboratorio.

Reproducir exactamente la señal de la figura 1.1 en el osciloscopio. Ver la señal
en modo AC y DC. ¿Qué diferencia se observa? ¿Para que sirven estos dos
modos de medida?

Medir la señal Vo(t) y comparar los resultados con lo obtenido teóricamente.

El objeto de este montaje es familiarizarse con los conceptos de offset, amplitud,
frecuencia, forma de onda que se encontrarán en el panel frontal del generador
de señal.
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Figura 1.2: R1 = 10KΩ ,R2 = 16KΩ, C = 33pF , Cosc = 90pF

MONTAJE 2.
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1. Trabajo teórico: En el circuito que se muestra en la figura 1.2a se ha aplicado un
escalón de tensión a la entrada Vi(t) entre 0 y 2 V.

Analizar el comportamiento transitorio de este circuito.

¿Cuál es la expresión de Vo(t)?. Hacer una representación de esta función.

Encontrar un tiempo de respuesta caracteŕıstico que denominaremos τ .

Si tomamos el origen de tiempos en el momento de la conmutación ¿qué tiempo
transcurre desde que la señal pasa por el 10% de su valor máximo hasta que
alcanza el 90%? Relacionar este tiempo, que llamaremos de subida, con el
tiempo caracteŕıstico τ .

Para realizar la medida de la señal Vo(t) en el laboratorio se coloca una sonda
del osciloscopio en paralelo con el condensador C. El efecto de la sonda es
como si pusiéramos en paralelo una capacidad Cosc ∼ pF y una resistencia
Rosc ∼ MΩ. Dichos valores no deben afectar a la medida salvo que en el propio
circuito encontremos valores parecidos, como es el caso de las capacidades
(Figura 1.2b).

Calcular el tiempo caracteŕıstico τ y el tiempo de subida para el circuito de la
figura 1.2b.

2. Trabajo de Spice: Realizar en Schematics un circuito equivalente al de la figura
1.2a.

Utilizar como fuente de entrada VPULSE para especificar que en un análisis
transitorio la fuente proporcionará un tren de pulsos de valor bajo V1=0V,
valor alto V2=2V, retraso TD=8µs, tiempo de subida TR=0.8ns, tiempo de
bajada TF=0.8ns, tiempo en alto PW=8µs y periodo PW=16µs. También se
puede utilizar una fuente de propósito general VSRC escribiendo pulse (0V 2V
8us 0.8ns 0.8ns 8us 16us) en el campo TRAN=. Con ello se especifica que en
un análisis transitorio la fuente proporcionará un tren de pulsos de valor bajo
0V, valor alto 2V, retraso de 8µs, tiempo de subida de 0.8ns, tiempo de bajada
de 0.8ns, tiempo en alto de 8µs y periodo de 16µs.

Activaremos el análisis transitorio para realizar un análisis de la evolución
temporal desde 0 hasta 16µs, tomando muestras cada 16 ns (“Step Ceiling”).

Representar en la misma gráfica las señales Vi(t) y Vo(t) durante 16µs y
comparar los resultados con lo obtenido teóricamente.

Realizar a continuación un estudio paramétrico variando el valor de la
capacidad. Insertar el śımbolo PARAMETERS (Ctrl+G (Get New Part)
= Param). Picar dos veces en el śımbolo. Seleccionar Name1=C (para un
condensador) y Value1=30p (ahora no es importante el valor seleccionado).
Picar en el condensador para la cual queremos hacer un barrido de valores
y seleccionar Value={C} (hay que escribir entre llaves el mismo nombre que
antes seleccionamos para Name1). Ir a SETUP en ANALYSIS. Seleccionar
Parametric Enabled. En la ventana que se nos muestra hacemos:

• Variable Type = Global Parameter

• Name = C (Igual que Name1)
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• Sweep Type = Linear/Decade

• Start Value /End Value / Increment = 33p/123p/30p.

• En SETUP-ANALYSIS mantener activado el análisis transitorio.

Ejecutar el programa y representar los resultados en una gráfica, junto con los
teóricos y posteriormente con los de laboratorio.

3. Trabajo de laboratorio: Montar este circuito y aplicar cambios de tensión a la
entrada entre 0 y 2 V. De las señales que proporciona el generador utilizar la que se
considere más adecuada.

Observar en el osciloscopio ambas señales.

Compararlo con el trabajo teórico.

Obtener el tiempo caracteŕıstico del transitorio haciendo uso de las medidas en
el 10 % y 90% de la señal.

Calcular la capacidad que introducen las sondas del osciloscopio.

El objeto de este montaje es: 1) familiarizarse con los selectores de fondo de escala
del osciloscopio, utilizando los valores prefijados en la escala de tiempos (pues se van
a medir tiempos) y los intermedios en la escala de tensiones (para situar la señal en
los indicadores de pantalla del osciloscopio 0% y 100%) y 2) ver cómo se modifica
un circuito por el hecho de medir sobre él.
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1.2. ANÁLISIS EN FRECUENCIA DE UN CIR-

CUITO.

OBJETIVO. Familiarizarse con herramientas de análisis de circuitos electrónicos: dia-
grama de Bode, frecuencia de corte, concepto de impedancia de salida (equivalente Theve-
nin). IMPORTANTE: ES OBLIGATORIO LA PRESENTACIÓN DE TODOS
LOS RESULTADOS TEÓRICOS Y LA RESPUESTA A TODAS LAS PRE-
GUNTAS PARA PODER REALIZAR LA SESIÓN DE LABORATORIO.

TRABAJO TEÓRICO. Considerar el circuito de la Figura 1.3.

Figura 1.3

Calcular la función de transferencia H(s) = Vo(s)/VI(s).

Calcular por separado Vo(s)/V2(s) y V2(s)/VI(s). Efectuar el producto y comprobar
que se cumple:

H(s) =
Vo

V2

V2

VI

Para los apartados siguientes tened en cuenta las conclusiones extráıdas en la
práctica 1.1 acerca de los efectos de la medida.

Representar el diagrama de Bode en módulo y fase de la función H(jw) que esperáis
encontrar en el laboratorio (incorporad el efecto de las sondas del osciloscopio).
¿Cómo denominaréis a este circuito visto el diagrama de Bode?. Determinar la
frecuencia de corte. Considerad que montáis un circuito con los siguientes elementos:
R1 = R2 = R = 100KΩ, C1 = C2 = 33pF .

Calcular el equivalente Thevenin (VT , ZT ) a la salida del circuito (usad notación
fasorial para VT ). Si VI(t) = 1V · sen(2πft), ¿cuál será la tensión Thevenin VT (t)
que veŕıamos en el laboratorio a la frecuencia f = 3.0kHz?, ¿y la impedancia
Thevenin ZT ?.

El proceso para obtener el equivalente Thevenin experimentalmente difiere del
teórico. Se fundamenta en lo siguiente: Como la impedancia Thevenin es compleja,
ZT = RT + jXT , tenemos que obtener tres parámetros: VT , RT y XT . Por tanto,
necesitamos realizar tres medidas:
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Figura 1.4: Medida experimental del equivalente Thevenin

1. Se mide la amplitud de la señal VO(t) sin conectar ningún elemento adicional
a la salida. Con ella conocemos la amplitud de VT (Fig. 1.4a)

2. Con la ayuda de una resistencia de prueba RP conectada a la salida se vuelve
a medir la amplitud de la señal a la salida, V ′

O(t) (Fig. 1.4b).

3. Se repite el paso anterior con otra resistencia R′
P , midiendo la amplitud de

V ′′
O(t). Obtener teóricamente las expresiones que permitan calcular RT y XT

en función de las dos resistencias de prueba y de las tres amplitudes de tensión
a la salida del circuito (Fig. 1.4b). Como se ha calculado teóricamente el valor
de RT y XT a 3.0kHz ¿qué valores de resistencias de prueba debéis elegir para
que |V ′

O| = |VT |/2 y |V ′′
O | = |VT |/4?

TRABAJO DE SPICE. Realizar en Schematics un circuito equivalente al de la figura
1.3, nombrando los nodos de entrada y salida como Vi y Vo, respectivamente.

Insertad una fuente VSIN indicando la amplitud y la fase en el parámetro AC=1V 0.
También se puede utilizar una fuente VAC, definiendo la amplitud ACMAG=1V y
la fase ACPHASE=0. Es mejor la primera, pues además permite hacer un análisis
transitorio como se vio anteriormente. De hecho fijaremos la amplitud VAMPL=1V,
la frecuencia FREQ=3k.

Activaremos el análisis AC sweep para realizar un análisis en frecuencia.

• Se seleccionará un analisis por decadas, indicando la frecuencia de inicio, fin y
el número de puntos por década.

• Representar el diagrama de Bode en módulo y fase. Para ello añadir en la
ventana de representación de resultados PROBE nuevas gráficas. Plot → Add
Plot + Trace → Add Trace y escribir DB(V(Vo)/V(Vi)) o P(V(Vi)/V(Vo))
para el diabrama de Bode en módulo y fase, respectivamente.

• Comparar con los resultados teóricos y posteriormente con los resultados
prácticos.

Activaremos ahora el análisis transitorio con el objeto de comprobar que los valores
de las resistencias de prueba RP y R′

P obtenidas teóricamente son correctas. Para
ello añadir una resistencia de prueba Rp al circuito de Spice (Figura 1.5).

• Determinar la amplitud de salida V o para los casos Rp = ∞, RP , R′
P .
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• Comprobar que la amplitud del segundo caso es la mitad del primero y la del
tercero la cuarta parte del primero. Si esto es aśı, habréis calculado bien RP y
R′

P .

Figura 1.5: Determinación del equivalente Thevenin con Spice.

TRABAJO PRÁCTICO

Montar el circuito de la figura 1.3 con R1 = R2 = 100KΩ y C1 = C2 = 33pF .

Obtener el diagrama de Bode experimental en módulo y fase de la función
H(jw) = VO(jw)/VI(jw). Entregar al final de la sesión representándolo en las figuras
1.6 junto con el resultado teórico. Para ello se realizarán a diferentes frecuencias las
medidas siguientes. Tensión pico a pico de las señales de entrada, VIp.p. , y de salida,
VOp.p. , y desfase entre ambas señales, φ. Con estas medidas se representaran en
función de la frecuencia las funciones 20 · log(VOp.p./VIp.p.) y φ.

Obtener experimentalmente la impedancia Thevenin vista a la salida del circuito
para la frecuencia f=3.0kHz.
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Diagrama de Bode. Nombre Alumno:

Figura 1.6: Plantillas para representar el diagrama de Bode (módulo y fase).
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Práctica 2

DISEÑO DE CIRCUITOS CON
AMPLIFICADOR OPERACIONAL

OBJETIVOS Diseñar circuitos con amplificadores operacionales (A.O.). Leer hojas
de caracteŕısticas de componentes electrónicos. Utilizar los modelos ideal y real del
amplificador operacional. Distinguir las diferencias de comportamiento del diseño
utilizando uno u otro modelo. Crear sub-circuitos con Spice.

FILTRO PASO ALTA

Diseñar un filtro paso alta de primer orden con un amplificador operacional 741
para obtener una ganancia de 100 y una frecuencia de corte de 1kHz.

Representar en una gráfica el diagrama de Bode en módulo del circuito diseñado
admitiendo que el amplificador operacional es ideal.

Representar en una gráfica el diagrama de Bode en módulo del circuito diseñado
admitiendo que el amplificador operacional es real (Efecto de la ganancia y ancho
de banda finito). Para ello hacer uso de las especificaciones del A.O. 741.

Crear en Schematics el modelo de amplificador operacional ideal (Fig. 2.1). En él
se utiliza una fuente de tensión controlada por tensión (E). Para guardarlo como
subcircuito y usarlo posteriormente en otros circuitos se le han añadido el conector
IF IN en los terminales de entrada y el conector IF OUT en el de salida. Realizar a
continuación los siguientes pasos:

• Guardar la hoja Schematics (Ej. Mimodelo00.sch).

• Pulsar File → Symbolize → Save As (Enter name for current symbol): (Ej.
Mimodelo00 ).

• Elegir la libreŕıa donde se guarda el subcircuito dentro del directorio UserLib.
Choose Library for Schematic Symbol: (Ej: MiLibreria.slb).

• Para poder utilizar el modelo hay que activar la libreŕıa donde se ha guardado.
Si se tiene activada otra libreŕıa definida por el usuario distinta de la que se
quiere usar habrá que desactivarla previamente (limitaciones de la versión de
estudiante). Para evitar estos problemas se recomienda guardar los subcircuitos
en la misma libreŕıa. Para la activación de la libreŕıa se pulsa Options→ Editor
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Configuraton → Library Settings → Browse → MiLibreria.slb (Pulsar Abrir)
→ Add* → OK

• Una vez realizados estos pasos se puede llamar al nuevo modelo: CRTL+G →
Mimodelo00

Figura 2.1: Modelo de amplificador operacional ideal en Spice.

Una vez creado el subcircuito comprobaremos nuestro diseño del filtro paso bajo
con Spice. Lo haremos de dos formas: a) usando el subcircuito creado y b) usando
el modelo de amplificador operacional real ua741 incorporado en Spice. A modo
de ejemplo, la figura 2.2 muestra el aspecto de un inversor de ganancia 100 con
amplificador operacional usando el modelo real ua741 e ideal creado en la Figura
2.1. Obtener el diagrama de Bode en módulo para Vo1/Vin y Vo2/Vin en vuestro
diseño. Comparar los resultados con lo obtenido teóricamente

Medir en el laboratorio el diagrama de bode en módulo y representarlo sobre las
gráficas teóricas y de Spice.

RESPUESTA A UNA SEÑAL TRIANGULAR

Considerar el mismo circuito del apartado anterior. A la entrada del mismo
considerar una señal triangular de periodo 50 ms variando entre -1 y +1 V. Calcular
la señal que se obtiene a la salida. Representar en una gráfica la señal de entrada
junto a la señal de salida.

Realizar este experimento en Spice. Para introducir una señal triangular se utilizara
la fuente VPULSE haciendo el tiempo en valor alto o bajo mucho menor que el
tiempo de subida/bajada. Utilizar los siguientes parámetros: valor bajo V1=-1V,
valor alto V2=1V, retraso TD=5ms, tiempo de subida TR=25ms, tiempo de bajada
TF=25ms, tiempo en alto PW=1ns y periodo PW=50ms. También se puede utilizar
una fuente de propósito general VSRC escribiendo pulse (-1V 1V 5ms 25ms 25ms
1ns 50ms) en el campo TRAN=.

Realizar este experimento en el laboratorio, medir la señal de salida para la entrada
anterior y representarla junto a los cálculos teóricos.
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Figura 2.2: Inversor con amplificador operacional usando el modelo real ua741 e ideal creado
en la Figura. 2.1.

RESPUESTA A UN TREN DE PULSOS

Para el mismo circuito considerar ahora una señal pulsante de periodo 1µs y variando
entre -1 y +1 V. Calcular la señal que se obtendŕıa a la salida admitiendo que el A.O.
es ideal. Repetir el cálculo en el caso de utilizar un modelo de A.O. con ganancia
y ancho de banda finito. Representar en una gráfica la señal de entrada junto a la
señal de salida para los dos casos. Comprobar los resultados con Spice especificando
los parámetros adecuados a la fuente VPULSE o VSRC. Realizar este experimento
en el laboratorio, medir la señal de salida para la entrada anterior y representarla
junto a los cálculos teóricos y de Spice.

Repetir lo anterior (teoŕıa, Spice y laboratorio) para una señal de entrada de periodo
1µs y variando entre 0 y +1 V.

¿Que ocurriŕıa si esta señal se la introducimos, en lugar de a vuestro circuito,
como entrada al circuito de la figura 2.3? Tomad como R y C los valores que
hayáis utilizado en vuestro diseño. Responded a esta pregunta y comprobadlo en el
laboratorio.
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Figura 2.3

EFECTO DEL SLEW RATE (SR). Considerando de nuevo vuestro diseño original
vamos a trabajar ahora con una señal seno a la entrada del circuito. ¿Cuál es el valor
del slew rate de vuestro operacional? ¿Cuál es la máxima amplitud de vuestra señal de
entrada para que la salida no se distorsione? Calcular teóricamente esa amplitud máxima
para las frecuencias de 1MHz y 0.1MHz. En el laboratorio introducir señales seno de
amplitudes mayores y menores al valor calculado teóricamente y comprobar qué ocurre.

Si en lugar de una señal seno a la entrada trabajamos con una señal pulsante de
periodo 1µs y variando entre -1 y +1 V. ¿Cambiará la salida con respecto a lo calculado
anteriormente por el efecto del slew rate? ¿Cuál es el valor máximo de la amplitud de
estos pulsos para que el slew rate no afecte a la salida? Además de realizar este cálculo
teórico comprobarlo en el laboratorio.
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Práctica 3

ECUACIONES BÁSICAS DE
SEMICONDUCTORES.

3.1. DENSIDADES DE PORTADORES EN FUN-

CIÓN DEL NIVEL DE FERMI.

OBJETIVO. Familiarizarse con las ecuaciones básicas de los semiconductores en
equilibrio termodinámico. Comprender los conceptos de nivel de Fermi, semiconductores
intŕınsecos y extŕınsecos.

Considerad un semiconductor de silicio a temperatura ambiente. Representar en una
gráfica las concentraciones de electrones, n, y huecos, p, en función de la posición del
nivel de Fermi con respecto al máximo de la banda de valencia EF − EV para los ĺımites
que se indican en la figura 3.1. Se va a trabajar con semiconductores degenerados y no
degenerados por lo que el nivel de Fermi puede estar tanto dentro de las bandas como en
el interior de la banda prohibida.

Para realizar este cálculo buscar en la bibliograf́ıa las expresiones adecuadas [1].
Elegir las escalas apropiadas (lineales o logaŕıtmicas) para tener una buena visión de
la representación. Elegir también las unidades apropiadas para las magnitudes que
representéis.

Figura 3.1
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3.2. EVOLUCIÓN DE LA DENSIDAD DE PORTA-

DORES CON LA TEMPERATURA.

Considerar un semiconductor tipo p o tipo n a vuestra elección, con una concentración
de impurezas aceptadoras o donadoras respectivamente elegida también por vosotros.
Elegid el tipo de impureza y buscad en la bibliograf́ıa la posición del nivel asociado a
la impureza en la banda prohibida. Representar en gráficas distintas la evolución con la
temperatura de la concentración de electrones, de huecos y de las impurezas ionizadas.
Representarlas todas también en una misma gráfica. Se observarán tres regiones muy
diferenciadas entre śı. Proponer en cada una de ellas una expresión anaĺıtica aproximada
que dé idea de la concentración de portadores mayoritarios.

Si definimos la temperatura T1 como la temperatura a la cual la concentración de
portadores mayoritarios se hace igual a la mitad de la concentración total de impurezas,
¿cuál es en vuestro caso esta temperatura? Indicarla en las gráficas anteriores.

Si definimos la temperatura T2 como la temperatura a la cual la concentración de
portadores minoritarios iguala a la concentración total de impurezas, ¿cuál es en vuestro
caso esta temperatura? Indicarla en las gráficas anteriores.

MATERIAL. Se aconseja el uso de software de resolución de ecuaciones matemáticas.
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3.3. ESTUDIO CUALITATIVO DE UNA UNIÓN

PN

OBJETIVO Familiarizarse con la distribución de diferentes magnitudes eléctricas a
lo largo de una unión PN: diagramas de bandas, campo eléctrico, concentraciones de
electrones y huecos y la densidad de carga.

HERRAMIENTAS Simulador didáctico bidimensional de dispositivos electrónicos
construido en el departamento de electrónica de la Universidad de Granada.

INTRODUCCIÓN Uno de los objetivos de la asignatura es proporcionar al estudiante
una descripción cualitativa de los nuevos dispositivos que se va encontrando. Esto es lo
que se pretende hacer con esta práctica y con la unión PN. Se propone estudiar una
unión PN en función de parámetros internos de esta estructura, como las concentraciones
de impurezas en las zonas P y N, y en función de parámetros externos, como la tensión
aplicada entre las zonas P y N. Para ver como se comporta esta unión en función de
estos parámetros analizaremos cómo se distribuyen ciertas variables eléctricas a lo largo
de dicha unión.

SIMULADOR DIDÁCTICO Para realizar este estudio se dispone de un simulador
de dispositivos fabricado en el marco de proyectos fin de carrera de la Ingenieŕıa
electrónica. Es un programa ejecutable de sencillo manejo llamado G4FETV5.exe. Al
ejecutarse se abre una ventana que permite elegir el dispositivo a simular. Se seleccionará la
unión PN.

A continuación se abre otra ventana de toma de datos. Hay que especificar los datos
siguientes:

Dopados de las regiones semiconductoras de la estructura. Se deben especificar
la concentración de impurezas donadoras y aceptadoras en la región semiconductora
izquierda y derecha. En cada una hay que especificar los valores de NA y ND. Se
recomienda usar 1010 cm−3 para el dopado de menor concentración en cada una de las
zonas. Aśı, en la región N indicar NA=1010 cm−3 y en la P ND=1010 cm−3. Para los otros
dopados seguir las recomendaciones del siguiente apartado. (Nota: El formato a emplear
es de la forma xxeyy que significa xx10yy; Ej. 3e15=3×1015).

El tamaño del dispositivo es fijo. Tiene unas dimensiones similares a las que se pueden
encontrar en dispositivos reales. Si se utilizan dopados bajos puede ocurrir que las zonas
de carga espacial ocupen todo el semiconductor. Si ocurre esto se recomienda disminuir
el dopado del semiconductor.

Existe la posibilidad de suavizar la transición de dopados de zonas N a zonas P a
través de un perfil gaussiano o por el contrario mantener una transición abrupta. Por
defecto utilizar la abrupta.

El programa puede usar en sus cálculos una movilidad constante o dependiente del
campo eléctrico. Usar por defecto movilidad constante (µn=1500 cm2s−1V−1, µp=450
cm2s−1V−1).

Una vez introducidos todos estos parámetros, el programa resuelve la ecuación de
Poisson bidimensionalmente y calcula la distribución de potencial eléctrico en toda la
estructura. A partir del potencial se pueden obtener otras variables como el campo
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eléctrico, las concentraciones de electrones y huecos y la densidad de carga. Estas variables
se pueden representar a lo largo de cortes verticales u horizontales en la estructura. Para
ello hay que indicar en la ventana de toma de datos donde se quiere la representación
(corte vertical u horizontal y ĺımites de la representación; si no se indican ĺımites la
representación se extiende a todo el rango del corte vertical u horizontal elegido).

La estructura a simular se muestra en la Fig. 3.2a. Es una unión PN en la se se
aplica una diferencia de potencial entre las regiones derecha e izquierda (zonas P y N).
Esta estructura está situada entre dos regiones aislantes de SiO2, y dos puertas metálicas
conectadas a tierra. La existencia de estas regiones aislantes no debe preocuparnos en
esta práctica. Su uso se comprenderá más adelante con el estudio de otros dispositivos
electrónicos. La razón de aparecer aqúı es porque el simulador se construyó inicialmente
para estructuras más complejas y se ha extendido su uso al estudio de estructuras más
simples, como es el caso de la unión PN.

Una vez terminada la simulación el programa muestra ventanas donse se observa la
distribución de variables electricas en la unión y devuelve ficheros con esas variables.
Dichos ficheros son (Fig. 3.2.b):

Matrices (90 filas x 94 columnas):

RESU00Na : impurezas aceptadoras en toda la estructura.

RESU00Nd : impurezas donadoras en toda la estructura

RESU00ne : distribución de la concentración de electrones por toda la estructura.

RESU00pe : distribución de la concentración de huecos por toda la estructura.

RESU00ro : distribución de la densidad de carga por toda la estructura.

RESU00V : distribución del potencial eléctrico por toda la estructura.

RESU00Exy : distribución del potencial eléctrico por toda la estructura.

Matrices de una columna (ejes):

Xpot: puntos donde se evalúan las variables en el eje x (Matriz 94 filas x 1 columna).

Ypot : puntos donde se evalúan las variables en el eje y (Matriz 90 filas x 1 columna).

Resumen de todas las variables de la ventana de datos: RESU00config.

REALIZACIÓN PRÁCTICA

Estimar el valor mı́nimo del dopado de las zonas N y P de la unión PN de silicio
para que la zona de carga espacial no agote toda la región P o la región N para el
dispositivo de la figura 3.2a. El espesor de cada una de las zonas N y P es de 225nm.
Hacer el cálculo para la unión en equilibrio y polarizada en inverso a 10 V.

Teniendo en cuenta el resultado anterior considerar una unión PN con dopados en
la zona N y P mayores o iguales a los calculados y diferentes entre śı un orden de
magnitud. Haciendo uso del simulador representar en una misma gráfica el campo
eléctrico a lo largo de la unión para tres valores de tensión diferentes V= 0 , 0.6
y -2 V. Representar también en una misma gráfica y para esas mismas tensiones
los diagramas de bandas a lo largo de la unión. (Para estas dos representaciones
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Figura 3.2: a) Dimensiones y discretización de la unión PN. b) Ficheros de resultados.

considerad una ĺınea horizontal hacia la mitad de la unión, ĺınea AA′ en la Fig. 3.2a).
Para estas tres tensiones y valores de los dopados elegidos, calcular anaĺıticamente
la anchura de la zona de carga espacial de las zonas P y N y el valor máximo del
campo electrico en la unión. Comprobar si coinciden con la simulación.

Considerad una nueva unión polarizada en inverso a 2 V. Representar en un sola
gráfica en escala semilogaŕıtmica lo siguiente: las concentraciones de electrones
y huecos para tres casos diferentes a) ND = N1, NA = N1 b) ND = N1,
NA = 2×N1 c) ND = N1, NA = 10×N1, donde N1 es un valor elegido teniendo
en cuenta el cálculo del primer apartado. (Nota: se ha definido ND ≡ NDN −NAN

y NA ≡ NAP −NDP , donde NDN es la concentración de impurezas donadoras en la
región N, NAN es la concentración de impurezas aceptadoras en la región N, NDP es
la concentración de impurezas donadoras en la región P y NAP es la concentración
de impurezas aceptadoras en la región P).

Representar también la distribución de la densidad de carga para estos tres casos
en una sola gráfica.

NOTA: Comentad todos los resultados. Una vez finalizada la simulación se aconseja
tratar los ficheros de resultados, bien con programas de matemáticas o con hojas de
cálculo.
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Práctica 4

CIRCUITOS BÁSICOS CON
DIODOS.

OBJETIVOS. Familiarizarse con el modelo en gran señal del diodo. Comprender el
funcionamiento de un diodo como parte de un circuito. Usar herramientas de análisis de
circuitos en régimen periódico permanente.

Figura 4.1

ANÁLISIS DE CIRCUITOS CON CONDENSADORES Y DIODOS.

1. Considérense los circuitos de la figura 4.1. A todos ello se aplica una señal de entrada
como se muestra en la figura. Se trata de una señal periódica permanente (la señal
que se observa ha sido precedida por infinitos pulsos iguales). Representar para cada
uno de los circuitos la señal de salida correspondiente superpuesta con la señal de
entrada, indicando los valores numéricos más significativos.

a) Admitir que CR À T . ¿En qué repercute esta condición en la cáıda de potencial
en los extremos del condensador?
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b) Para el cálculo de la tensión de salida considerar junto a la anterior condición
que la corriente media que circula por el condensador a lo largo de un periodo
es cero < iC(t) >= 0 (condición de régimen periódico permanente).

2. Para el circuito de la figura 4.1h se propone hacer un análisis más exahustivo.

a) Encontrar las expresiones de la cáıda de potencial en los extremos del
condensador y de la tensión de salida en función del tiempo para un producto
CR arbitrario. Nota: imponer condiciones de contorno periódicas (se sigue en
régimen periódico permanente).

b) Representar gráficamente estas dos señales en función del tiempo para los
siguientes casos: a) CR À T , b) CR = 2T y c) CR ¿ T . Indicar en todas la
gráficas los valores más significativos. Comprobar que los resultados del caso
a) son iguales que los calculados en la sección anterior.

3. Comprobar en el laboratorio todos y cada uno de los apartados anteriores. Añadir
los resultados del laboratorio a las gráficas obtenidas teóricamente. Elegir los valores
de los componentes de forma que se cumplan las hipótesis de trabajo. Para el
diodo estimar la potencia máxima que va a disipar y elegir uno de acuerdo con
esta estimación (no será una potencia alta, justificar por qué).

Nota: para el diodo considerar que Vγ = 0.6V y la resistencia serie es nula en toda la
práctica.
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Práctica 5

AMPLIFICADOR OPERACIONAL.
APLICACIONES NO LINEALES.

OBJETIVOS. Aprender a diseñar funciones básicas empleadas en la electrónica
usando el amplificador operacional. Trabajar con el amplificador operacional tanto en
realimentación negativa y lazo cerrado como en lazo abierto.

FUNCIÓN A.

1. Considerar el circuito de la figura 5.1. Calcular la caracteŕıstica de transferencia
Vo − Vi

2. Si vi = 2sen(ωt) V, f = 1 kHz representar vo(t) junto a vi(t) en una misma gráfica.

3. Montar en el laboratorio y comprobar.

Figura 5.1 Figura 5.2

FUNCIÓN B.

1. Considerar el circuito de la figura 5.2. Si vi = 2sen(ωt) V, f = 1 kHz representar
vo(t) junto a vi(t) en una misma gráfica.

2. ¿Cuánto deben valer R y C para que el mı́nimo de vo(t) sea igual al 95% del máximo
de vi(t)? Repetir para el 90%, 80 %, 70%.

3. ¿Qué nombre le pondŕıas al circuito?

4. Elegir uno de los casos anteriores y montarlo en el laboratorio.
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Práctica 1

AMPLIFICADOR CMOS

1.1. EL CANAL DE INVERSIÓN EN UN MOS-

FET.

OBJETIVO Familiarizarse con la distribución de electrones, huecos, y la densidad de
carga en la región de canal de un transistor de efecto campo metal óxido semiconductor
(MOSFET). Estudiar cómo evoluciona la distribución de estas cargas al variar la tensión
de puerta VG.

HERRAMIENTAS Simulador didáctico bidimensional de dispositivos electrónicos
construido en el departamento de electrónica de la Universidad de Granada.

INTRODUCCIÓN No es objetivo de la asignatura CCE proporcionar herramientas
anaĺıticas para determinar cómo se distribuye la carga en el transistor MOSFET. Estas
herramientas son objeto de estudio en una asignatura más avanzada dentro de Ingenieŕıa
electrónica: ”Dispositivos electrónicos y fotónicos”. Sin embargo, para hacer uso de las
relaciones I-V del dispositivo, y a partir de ellas encontrar los modelos de circuito del
MOSFET es necesario tener una idea cualitativa de su funcionamiento. Esto es lo que se
pretende con esta práctica.

Para ello se propone estudiar un MOSFET en función de la tensión aplicada a
la puerta. Se conocen los dopados de las regiones que constituyen el dispositivo y se
considera inicialmente que la fuente, drenador y sustrato están conectados a tierra (Fig
1.1). Se propone variar la tensión VG y observar cómo se distribuyen a lo largo del
eje AA’las concentraciones de electrones y huecos y la densidad de carga. Este estudio
permitirá estimar la tensión a la cual se produce la inversión de carga en el semiconductor
cerca de la interfaz Si-SiO2.

Se considera que hay inversión cuando la concentración de minoritarios en la interfaz
Si-SiO2 se iguala a la concentración de mayoritarios en la zona neutra. Si el semiconductor
es tipo N el canal de inversión es de huecos y conecta las regiones P+ de fuente y drenador.
Si se aplica una tensión VDS entre fuente y drenador este canal permitirá el paso de una
corriente eléctrica entre dichos terminales. Si esta conexión desaparece también lo hace la
corriente eléctrica.
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Figura 1.1: Esquema del MOSFET

SIMULADOR DIDÁCTICO Para realizar este estudio de la evolución de la carga
con la tensión de puerta se dispone de un simulador de dispositivos fabricado en el marco
de proyectos fin de carrera de la Ingenieŕıa electrónica. Es un programa ejecutable de
sencillo manejo llamado G4FETV5.exe. Al ejecutarse se abre una ventana que permite
elegir el dispositivo a simular. Se seleccionará el MOSFET.

A continuación se abre otra ventana de toma de datos. Hay que especificar los datos
siguientes:

Dopados de las regiones semiconductoras de la estructura. Se deben especificar la
concentración de impurezas donadoras y aceptadoras en:

El polisilicio, que actúa como puerta; está muy impurificado para alcanzar un
comportamiento casi metálico. Para la práctica se recomienda usar ND=1020 cm−3,
NA=1010 cm−3. El formato a emplear es de la forma xxeyy que significa xx10yy; Ej.
3e15=3x1015.

Puertas laterales izquierda y derecha: hacen las funciones de fuente y drenador
respectivamente. En esta práctica se sitúan a cero voltios. Si se elige un transistor
canal P se pueden emplear los siguientes valores: ND=1010 cm−3, NA=1019 cm−3.

Canal: zona semiconductora donde se pretende formar el canal de inversión próximo
a la interfaz Si-SiO2. Si se elige un transistor canal P se pueden emplear los siguientes
valores: ND=1017 cm−3, NA=1010 cm−3.

El tamaño del dispositivo es fijo. Tiene unas dimensiones similares a las que se pueden
encontrar en dispositivos reales. Si se utilizan dopados bajos puede ocurrir que las zonas
de carga espacial ocupen todo el semiconductor. Si ocurre esto se recomienda disminuir
el dopado del semiconductor.

Existe la posibilidad de suavizar la transición de dopados de zonas N a zonas P a
través de un perfil gaussiano o por el contrario mantener una transición abrupta. Por
defecto utilizar la abrupta.

El programa puede usar en sus cálculos una movilidad constante o dependiente del
campo eléctrico. Usar por defecto movilidad constante (µn=1500 cm2s−1V−1, µp=450
cm2s−1V−1).
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Una vez conocidos estos parámetros el programa resuelve la ecuación de Poisson
bidimensionalmente y calcula la distribución de potencial eléctrico en toda la estructura.
A partir del potencial se pueden obtener otras variables como el campo eléctrico, las
concentraciones de electrones y huecos y la densidad de carga. Estas variables se pueden
representar a lo largo de cortes verticales u horizontales en la estructura. Para ello hay que
indicar en la ventana de toma de datos donde se quiere la representación (corte vertical
u horizontal y ĺımites de la representación; si no se indican ĺımites la representación se
extiende a todo el rango del corte vertical u horizontal elegido).

El programa devuelve también ficheros donde se guardan las siguientes variables (Fig.
1.2.b):

Matrices (94 filas x 90 columnas):

RESU00Na : impurezas aceptadoras en toda la estructura.

RESU00Nd : impurezas donadoras en toda la estructura

RESU00ne : distribución de la concentración de electrones por toda la estructura.

RESU00pe : distribución de la concentración de huecos por toda la estructura.

RESU00ro : distribución de la densidad de carga por toda la estructura.

RESU00V : distribución del potencial eléctrico por toda la estructura.

Matrices de una columna (ejes):

Xpot: puntos donde se evalúan las variables en el eje x (Matriz 94 filas x 1 columna).

Ypot : puntos donde se evalúan las variables en el eje y (Matriz 90 filas x 1 columna).

Resumen de todas las variables de la ventana de datos: RESU00config.

Figura 1.2: a) Dimensiones y discretización del MOSFET. b) Ficheros de resultados.

REALIZACIÓN PRÁCTICA Considerar un MOSFET canal P. Considerad distin-
tas tensiones de puerta comprendidas en el intervalo [-1.5, 1.5] V. Introducid los datos
del MOSFET en la ventana de datos del simulador y obtener la distribución de varia-
bles eléctricas para distintos valores de la tensión de puerta dentro de este intervalo. Una
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vez finalizada la simulación se aconseja trabajar con los ficheros de resultados, bien con
programas de matemáticas o con hojas de cálculo.

Para cada tensión de puerta representar una pareja de gráficas. En una de ellas la
concentración de electrones y huecos en función de la posición y para un corte
vertical situado en la mitad de la estructura. En la otra gráfica representar la
densidad de carga en función de la variable y. Identificar distintas regiones dentro
del semiconductor dependiendo del tipo de carga que aparece en él.

Para cada valor de la tensión de puerta elegido determinar la anchura de la zona de
carga espacial que resulta y representarla en función de VG en una gráfica aparte.

Para cada valor de la tensión de puerta elegido determinar la anchura de la zona de
inversión que resulta y representarla en función de VG en una gráfica aparte.

Para cada valor de la tensión de puerta elegido determinar el valor de la
concentración de electrones y huecos en la interfaz Si-SiO2 y representarlas en una
misma gráfica en función de VG.

A partir de estos resultados ¿a qué tensión consideráis que aparece el canal de
inversión? (esta tensión definiŕıa el umbral de conducción).

A partir de estos resultados ¿a que tensión consideráis que todo el semiconductor
es neutro (no existen zonas de carga espacial ni zonas de inversión o acumulación
de carga). A esta tensión se la denominaŕıa de banda plana.

ENCUESTA SOBRE EL SIMULADOR Responded, por favor, a las siguientes
preguntas sobre esta práctica:

Horas de trabajo empleadas para realizar la práctica:

Consejos de mejora del simulador:

¿Cómo valoráis esta práctica en relación con otras realizadas en la asignatura? Mejor,
peor, igual:

Añadir cualquier comentario que sea de interés para mejorar la práctica:
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1.2. EXTRACCIÓN DE PARÁMETROS.

OBJETIVO Para dos transistores MOSFET uno canal n y otro p: Medida de curvas
caracteŕısticas ID − VDS, obtención de la curva ID − VGS en la zona de saturación y
determinación de los parámetros de gran señal VT , kn y VA, y de pequeña señal gm y ro.

FUNDAMENTO TEÓRICO Los modelos clásicos tensión-corriente de MOSFET en
inversión parten de simplificaciones que restringen su aplicabilidad pero aportan expresio-
nes fácilmente manejables y de las que se pueden extraer parámetros caracteŕısticos. Si se
analiza el modelo de lámina de carga, consideramos que los extremos de fuente y drenador
están fuertemente invertidos (es decir podemos utilizar el modelo aproximado de fuerte
inversión), y nos situamos en la región lineal del transistor, la corriente de drenador en
un transistor de canal n viene dada por:

ID = kn

[
(VGS − VT )VDS − V 2

DS

2

]
VDS < VDSsat (1.1)

ID =
kn

2
(VGS − VT )2 (1 + λ(VDS − VDSsat)) VDS > VDSsat (1.2)

donde VDSsat es el valor de VDS que maximiza la ecuación 1.1:

VDSsat = VGS − VT

IDSsat = ID(VDS = VDSsat)

Si la tensión VDS es tal que la corriente viene descrita por la ecuación (1.1) se dice que
el dispositivo está trabajando en la región triodo. Si por el contrario la corriente viene
descrita por la ecuación (1.2) decimos que el dispositivo se encuentra en saturación.

kn, VT y λ = 1/VA son parámetros que describen a este dispositivo y sus valores son
los que deberemos encontrar en esta práctica. VT se define como tensión umbral, λ es la
pendiente de la curva en saturación (Fig. 1.3) y kn se relaciona con parámetros internos
del mismo:

kn = k′
W

L
, k′ = µnCox

ID

VDS

IDsat

VDsat

8=0

8ñ0

Figura 1.3: Curva ID − VDS del MOSFET
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REALIZACIÓN PRÁCTICA Considerar dos transistores MOSFET, uno canal n y
otro canal p. Repetir los siguientes puntos para cada uno de ellos.

1. Elegir un valor de la tensión de drenador VDS en el que el transistor se encuentre en
saturación. Medir una curva experimental ID−VGS para el valor VDS elegido. Extraer
los parámetros VT y kn y calcular a partir de ellos el parámetro de pequeña señal
gm(ID). Mediante cociente de incrementos ∆ID/∆VGS volver a determinar gm(ID).
Representar en una sola gráfica las dos curvas gm(ID). Comentar los resultados.

2. Elegir dos valores de VGS tal que la diferencia entre ellos sea de al menos 3 V. Medir
para cada uno de ellos una curva completa ID − VDS. Extraer los parámetros VA y
ro(ID).

3. Con los valores de los parámetros obtenidos en la práctica representar ID − VDS

para los dos valores de VGS elegidos. Comparar estas curvas teóricas con las curvas
experimentales en una misma gráfica.

4. Presentar los resultados de esta práctica al inicio de la sesión de prácticas siguiente.
Se valorará el cuidado puesto por el alumno en la representación de las gráficas.

Figura 1.4: Esquema de los transistores y conexiones de un circuito integrado 4007

MATERIAL NECESARIO

Circuito integrado 4007 (una unidad), (Fig. 1.4).

Trazador de curvas 571. (Atender a las indicaciones del manual sobre las medidas
en un FET pag. 3-12)
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1.3. AMPLIFICADOR CMOS

OBJETIVO. El objetivo de esta práctica es construir una etapa amplificadora,
utilizando transistores MOS (Figura 1.5), aśı como estimar los parámetros que la
caracterizan (ganancia y resistencia de entrada) en función de los componentes que
constituyen el circuito.

Figura 1.5: Esquema de la etapa amplificadora basada en circuitos MOS

MATERIALES. Los materiales necesarios para realizar esta práctica aparecen en la
tabla 1.1.

ELEMENTOS UNIDADES

Circuito integrado 4007 1
Condensadores

0.1µF 2
Resistencias

240Ω 1
1MΩ 2
10MΩ 1
10kΩ 1

Tabla 1.1: Materiales

MÉTODO. El circuito integrado 4007 que se va a emplear en esta práctica consta de
seis transistores MOS, tres de canal N y otros tantos de tipo P. En la Figura 1.6 puede
observarse la distribución de los mismos en el integrado, aśı como las distintas conexiones
entre sus terminales. Con objeto de facilitar el montaje de la etapa amplificadora, se
ha incluido la numeración de los distintos pines que deben emplearse en el montaje de la
etapa amplificadora (Figura 1.5). Del mismo, se hace notar que los terminales 14 y 7 están
conectados a los substratos de todos los transistores de tipo p y n, respectivamente. En
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Figura 1.6: Esquema de los transistores y conexiones de un circuito integrado 4007

consecuencia, deben conectarse las tensiones adecuadas, evitando, en todo caso, sobrepasar
una tensión de 18 V entre ambos.

Por otro lado, la entrada AC que se introducirá en A será una señal seno, de amplitud
igual a 50 µVpp y 10 kHz de frecuencia. Obviamente, la magnitud de esta señal no puede
obtenerse de un simple generador de señal sin más. Es por ello que se empleará un partidor
de tensión a la entrada del circuito (Figura 1.7). Para que el circuito que de la Figura 1.7
sea un buen partidor de tensión (es decir, que proporcione un voltaje aproximadamente
constante al acoplarle una carga) es necesario que la intensidad que se desv́ıe hacia la etapa
amplificadora se la menor posible. Por este motivo, Rp2 se debe elegir lo más pequeña
posible (próxima a 250Ω, 240Ω en nuestro caso), mientras que Rp1 (∼ 1 MΩ) disminuye
la intensidad de la entrada producida por el generador de señal (200 mVpp) en la entrada
adecuada para la etapa amplificadora.

Figura 1.7: Partidor de tensión necesario para proporcionar una entrada de 50 µVpp a la etapa
amplificadora.

TRABAJO DEL ALUMNO. Para todos los cálculos haga uso de los resultados
obtenidos en la práctica anterior. Los cálculos teóricos se presentarán al profesor al inicio
de la sesión de prácticas. Los resultados prácticos se presentarán al profesor al final de la
sesión.

1. ¿A qué tensiones deberá conectar los sustratos de todos los MOSFETs?

2. Determine teóricamente el valor de la tensión en los nodos E, C, B y D. Hacer
este cálculo con y sin resistencia RL(Advertencia: tratar adecuadamente la tensión
continua y alterna apliada al circuito).
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3. Calcular la relación vC/vA. ¿Cuál es el efecto de la resistencia RL?

4. Aumentar lentamente la amplitud de la señal de entrada en el nodo A y comprobar
cómo afecta a la señal de salida. Estimar teóricamente la máxima amplitud de
trabajo, Amax.

5. Sustituir la resistencia conectada entre los nodos C y B, RG, por otra de 1 MΩ?.
Calcular la ganancia en tensión vC/vA y la resistencia de entrada Rin (con y sin
resistencia de carga) para la misma señal de entrada seno, de amplitud igual a 50
µVpp y 10 kHz de frecuencia.

6. Simular el circuito con Spice y responder a las cuatro preguntas anteriores. (NOTA:
Puesto que el circuito 4007 no forma parte de la base de elementos de Spice, los
transistores que pueden emplearse en la simulación son MBREAK-N y MBREAK-
P. La opción Edit−→Model−→Edit Instante Model, permite fijar los valores de los
parámetros VTn,p , kn,p y VAn,p . Si se quiere guardar el modelo para usos futuros seguir
los pasos indicados en el apéndice B.

7. Una vez montado el circuito real hacer las medidas necesarias para responder a las
preguntas 2-5. ¿Coinciden los resultados? Razonar la respuesta. (El circuito debe
venir montado antes de iniciar la sesión de laboratorio).
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Práctica 2

AMPLIFICADOR MONOETAPA
CON TRANSISTOR BIPOLAR.

OBJETIVO El objetivo de esta práctica es construir un amplificador con un transistor
bipolar en configuración emisor común y caracterizarlo midiendo una serie de parámetros
como son la ganancia en tensión, la resistencia de entrada, la resistencia de salida y la
respuesta en frecuencia. Para cubrir este objetivo se tendrá que pasar por dos etapas
previas: la extracción de parámetros del transistor bipolar y la polarización del transistor.

2.1. EXTRACCIÓN DE PARÁMETROS.

El objetivo de este apartado es familiarizarse con las curvas caracteŕısticas de un
transistor bipolar, medirlas y determinar las ganancias en corriente en gran señal (βF )
y en pequeña señal hfe y el parámetro hoe . Los transistores que se emplearán serán
BC547B, u otros similares que quiera utilizar el alumno. Aprovechando las horas de
apertura del laboratorio con los monitores de prácticas, el alumno medirá curvas I−V del
transistor bipolar (se hará uso del trazador de curvas 571 y de la experiencia adquirida en
la extracción de parámetros en un MOSFET) y a partir de ellas extraerá los parámetros
necesarios para poder hacer el diseño con estos transistores. Comprobar que los parámetros
extráıdos experimentalmente coinciden con los proporcionados por el fabricante. Dibujar
curvas donde se muestren conjuntamente los datos del fabricante con los obtenidos por el
alumno. Presentar estas gráficas al profesor al inicio de la sesión donde se montarán los
circuitos de los apartados siguientes.

FUNDAMENTO. En la figura 2.1 se muestra el modelo de parámetros h (pequeña
señal) de un transistor bipolar en emisor común. En él se ve como la corriente de colector
se relaciona con la corriente de base y la tensión colector emisor:

ic = hfeib + hoevce (2.1)

hfe =
(

ic
ib

)

vce=0

=
(

∆IC

∆IB

)

VCE=cte

(2.2)

hoe =
(

ic
vce

)

ib=0

=
(

∆IC

∆VCE

)

IB=cte

(2.3)
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+

-

b c

e

hoe

h ife b

h vre ce

hie

ib ic

Figura 2.1

Figura 2.2: hfe = (ICi − ICj)/(IBi − IBj), IC = (ICi + ICj)/2

REALIZACIÓN PRÁCTICA. Obtención de los parámetros hFE(≡ βF ) y hfe del
transistor a partir de curvas IC − VCE (Figura 2.2) y del parámetro hoe (Figura 2.3).

Las curvas hFE, hfe y hoe se deben representar en función de IC con VCE tomando
un valor constante (Figuras 2.2 y 2.3).

Para presentar los resultados de esta práctica es necesario fijarse como los
fabricantes de transistores bipolares representan estos mismos parámetros en
las hojas caracteŕısticas. En las tres gráficas, con los resultados experimentales
obtenidos, representar también los valores que proporciona el fabricante para la
serie de transistores elegidos por el estudiante.

Si admitimos que el parámetro hre es despreciable identificar el resto de los
parámetros h con los parámetros del modelo en π.

12



Figura 2.3: hoe = (ICi − ICj)/(VCEi − VCEj), VCE = (VCEi + VCEj)/2

2.2. POLARIZACIÓN DEL TRANSISTOR.

R1

R2

RC

RE

12V

Figura 2.4: Transistor: BC107B, BC547B o similar.

FUNDAMENTO TEÓRICO Se trabajará con el circuito autopolarizado (Fig. 2.4).
El primer paso es el diseño del circuito, es decir, encontrar los valores de las resistencias
para que el transistor trabaje en un punto de operación determinado, definido por IC y
VCE.

Para calcular los valores de RC y RE acudiremos a la relación:

Vcc = VCE + IC(RE + RC), (2.4)

suponiendo despreciable la intensidad IB frente a IC .

REALIZACIÓN PRÁCTICA IMPORTANTE: ES OBLIGATORIO LA PRESEN-
TACIÓN DE LOS RESULTADOS TEÓRICOS PARA PODER REALIZAR LA SESIÓN
DE LABORATORIO

En esta práctica vamos a suponer VCE = 5V y IC = 5mA, y vamos a montar el circuito
anterior (Fig. 2.4) para los dos casos siguientes:

1. RE = 0 .

Para obtener R1 y R2 se razona de la siguiente forma:
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R1

R2

RC

12V

Ip

IB

Figura 2.5: Polarización del transistor con RE = 0.

Para que estas dos resistencias constituyan un buen partidor es necesario que
Ip À IB. Supongamos Ip = 10IB = 10IC/β

Vcc = IpR1 + VBE (2.5)

VBE = R2(Ip − IB) (2.6)

Como no dispondréis de los valores exactos de las resistencias elegir las más
aproximadas.

Con los valores reales calcular teóricamente VCE e IC .

¿Qué ocurriŕıa si no se satisface la condición Ip À IB y tenéis que cambiar de
transistor, o envejece el que tenéis, variando sus parámetros?

En el laboratorio:

Comprobar que se consigue ese punto de operación.

Acercar un objeto caliente al transistor y medir de nuevo IC y VCE.
¿Qué ocurre?.

2. RE = RC/3. Para el diseño del circuito debo tener en cuenta un factor de
inestabilidad que nos da idea de lo inestable que es el circuito frente a variaciones
de la temperatura (Ver el apéndice A). Este factor se define como:

S =
(RB

RE
+ 1)(1 + β)

RB

RE
+ 1 + β

(2.7)

El circuito será más inestable cuanto mayor sea el valor de S. El caso ĺımite de mayor
estabilidad es cuando RE = ∞ correspondiendo a un valor de S = 1. Interesa un
cociente RB/RE pequeño.

Suponer en este circuito un valor de S = 11. Calcular de nuevo todos los valores
de las resistencias, elegir las más próximas, recalcular VCE e IC y repetir el mismo
proceso de medida que en el apartado anterior.
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Las ecuaciones que describen este circuito se obtienen hallando el equivalente
Thevenin del partidor de tensión de la figura 2.4 y analizando el circuito resultante
(Fig. 2.6.

¿Cuál de los dos casos es más estable?, ¿por qué?.

VB
RE

RC

12V

RB

Figura 2.6: Aplicación del equivalente Thevenin al divisor de tensión de la figura 2.4.

3. Situaros en el primer apartado de la práctica del amplificador con transistores
bipolares BJT. Al polarizar el transistor bipolar con la configuración RE=0 (fig.
2.5) podréis observar que al colocar el dedo encima del transistor vaŕıa la corriente
de colector.

Ahora vais a estimar la variación de temperatura que experimentará vuestro
transistor. Admitir que la temperatura de laboratorio es de 300K y el punto de
operación de vuestro transistor medido a esta temperatura viene dado por IC=5
mA y VBE=0.6 V.

a) Encontrar una expresión para IC donde la temperatura T quede expresada de
forma expĺıcita. (entregar antes de realizar la prácica).

b) Si en esta expresión hay alguna constante o parámetro que desconozcáis
calcularla a partir de los datos del problema a 300 K. (entregar antes de realizar
la prácica).

c) Conocida esta constante evaluar la expresión de la corriente IC a 301K, 302 K,
303K,... (entregar antes de realizar la prácica).

d) Anotar la variación de corriente medida en vuestra práctica cuando calentéis
el transistor.

e) Con todos estos datos ¿qué incremento de temperatura experimenta realmente
el transistor?
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2.3. AMPLIFICADOR MONOETAPA CON TRAN-

SISTOR BIPOLAR.

FUNDAMENTO TEÓRICO Para construir un amplificador con transistor lo
primero que se debe hacer es polarizarlo, eligiendo un punto de trabajo adecuado. En el
caso de amplificadores donde se requiera una comportamiento lineal la región que cumple
esta condición es la zona activa. En el apartado 2.2 se ha polarizado un transistor bipolar
en la región activa. Aprovechando dichos datos vamos a añadir los elementos que dan la
forma final al amplificador monoetapa (Fig. 2.7).

+

-
VS

12 V

Vo

IL

CC

CERERB2

RB1 RC

RL

CBRX

Ri RO

RS

V2 V1

I1

Figura 2.7: Amplificador monoetapa con transistor bipolar.

Condensadores CC y CB: Impiden que la señal continua de esta etapa afecte a etapas
anteriores o posteriores, o dicho de otra forma que etapas anteriores o posteriores
modifiquen el punto de operación que se hab́ıa elegido de partida. En este caso lo que
puede afectar al punto de operación de nuestra etapa es la resistencia del generador
y la resistencia de carga. Tomar CC ≈ 10µF y CB ≈ 10µF

Condensador CE: En continua no afecta a la resistencia de emisor, garantizando
la estabilidad que proporciona la resistencia RE. Sin embargo, a las frecuencias de
trabajo se elige su valor de tal forma que su impedancia sea prácticamente nula,
cortocircuitando por tanto la resistencia de emisor y permitiendo con ello aumentar
la ganancia en tensión de la etapa. Tomar CE ≈ 220µF

Resistencia de carga RL: representa la resistencia que presenta cualquier sistema
sobre el que se va a recoger la señal amplificada. Tomar RL = 10kΩ

Resistencia Rx: esta resistencia se utiliza por problemas particulares de este circuito
y del generador de señal que se utilizará en el laboratorio. Debido a la alta ganancia
en tensión que proporciona este amplificador, si no se utilizan señales de entrada
de amplitud suficientemente pequeña la salida puede quedar recortada a sus valores
extremos (0V, 12V). Se utiliza esta resistencia para absorber parte de la tensión que
proporciona el generador de entrada. Tomar Rx = 20kΩ
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REALIZACIÓN PRÁCTICA

Trabajo teórico (IMPORTANTE: ES OBLIGATORIO LA PRESENTA-
CIÓN DE ESTE TRABAJO PARA PODER REALIZAR LA SESIÓN DE
LABORATORIO).

Calcular las ganancias Av1(s) = VO(s)/V1(s) y Av2(s) = VO(s)/V2(s) (admitir que
la impedancia de los condensadores CC y CB es nula). Representar el diagrama de
Bode en ambos casos.

+

-
VS

RX

RS

V2 V1

I1

Vo

IL

RLRCCERE

rB

RB2RB1

g vm be

+ -vbe

Figura 2.8: Estudio en pequeña señal del amplificador.

¿Es válido el modelo utilizado para el transistor a altas frecuencias? Si no lo es,
¿cuál seŕıa el modelo correcto?.

Calcular la resistencia de entrada Ri a una frecuencia donde la ganancia sea máxima
(impedancia del condensador CE nula)

Ri =
V1

I1

(2.8)

Calcular la resistencia de salida a la misma frecuencia

RO =
(

VO

−IL

)

RL=∞,Vs=0

(2.9)

A esa misma frecuencia calcular la amplitud máxima que puede soportar la tensión
en los nodos V1 y V2 para que no se distorsione la salida.

Trabajo de Spice

Crear en Schematics un circuito como el de la figura 2.7. Obtener el diagrama de
Bode en módulo para las ganancias Av1(s) y Av2(s). Si el transistor elegido no forma
parte de la base de elementos de Spice crear un modelo nuevo a partir de los datos
obtenidos en el apartado anterior, tal y como se indica en el apéndice B.

Crear en Schematics un circuito como el de la figura 2.8. Se deberá utilizar una
fuente de corrietne dependiente de tensión G. Obtener el diagrama de Bode en
módulo para las ganancias Av1(s) y Av2(s).

Comparar los resultados de Spice entre śı y con lo teóricos. Posteriormente con los
de laboratorio.
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Trabajo práctico.

Montar el circuito de la figura 2.7 con los valores de los componentes utilizados en el
cálculo teórico, que deben coincidir con los del aprtado de polarización del transistor
con RE no nula.

Antes de añadir los elementos adicionales que hemos comentado más arriba
comprobar que el transistor se encuentra bien polarizado. Después, terminar de
montar el circuito.

Medida del diagrama de Bode en módulo para una de las ganancias Av1(s) o Av2(s).
Medir a partir de 10 Hz.

Medida de la resistencia de entrada Ri en el rango de frecuencia de ganancia máxima.
Utilizar una resistencia de prueba Rp de valor próximo a la Ri calculada teóricamente
(Fig. 2.9).

VA =
Ri

Ri + Rp

Vs (2.10)

+

-
VS

Rp

Ri

VA

+

-

Figura 2.9: Medida de la resistencia de entrada.

Medida de la resistencia de salida RO en el rango de frecuencia de ganancia máxima.
Medir la salida en circuito abierto y con una resistencia parecida a la RO encontrada
teóricamente (Fig. 2.10).

+

-
Vt

RO

+

-
Vt

RO

R’Vo1 Vo2

+

-

+

-

Figura 2.10: Medida de la resistencia de salida.

Comparación con los resultados teóricos. Crear tablas o gráficas comparativas.
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Práctica 3

AMPLIFICADOR MULTIETAPA
CON TRANSISTORES
BIPOLARES.

REALIZACIÓN PRÁCTICA En esta práctica vamos a diseñar un amplificador que
cumpla unos determinados requisitos de ganancia de tensión, AV , resistencia de entrada,
Ri, y resistencia de salida, RO. El profesor entregará con antelación las especificaciones
exactas a cada estudiante.

Diseño: AV ≥ ...; Ri ≥ ...kΩ; RO ≤ ...kΩ.

Antes de acudir al laboratorio se debe diseñar el circuito, realizando manualmente los
cálculos necesarios para que se cumplan las especificaciones requeridas. Posteriormente, se
deberá comprobar mediante simulación. Las simulaciones deben ser completas y en ellas
se mostrará gráficamente los resultados obtenidos.

En el laboratorio se debe tomar nota del material utilizado, caracteŕısticas de los
componentes y resultados obtenidos en las mediciones. Para los cálculos iniciales se puede
utilizar como valor estimado los proporcionados por el fabricante en su hoja caracteŕıstica.

Primero hay que montar una por una cada una de las etapas que forman el circuito
y comprobar que cumplen los requisitos de polarización y ganancia en tensión esperados.
Sólo entonces se puede pasar al montaje del circuito completo.

Por último se medirá la ganancia en tensión en función de la frecuencia, AV vs. f y
la resistencia de entrada y salida para una frecuencia intermedia (zona de “ganancia en
tensión”=constante).

Nota: Es posible que con la tensión mı́nima de entrada proporcionada por el generador
la señal en sus terminales de salida no se visualice correctamente (puede aparecer
recortada). Para evitar este problema el generador de tensión permite atenuar en 20dB
(factor 10) la señal de entrada. Es fundamental tratar de maximizar el rango de tensiones
aplicables. Utilizar transistores bipolares BC547B con los parámetros proporcionados por
el fabricante. Tensión de alimentación: VCC =15V

19



Apéndice A

FACTOR DE INESTABILIDAD.

Ic0

IB I ’B

IC

I ’C

IE

RB

RC

RE

VCC

VBB

IC

$I ’B

0.6V
I ’BIB

IC0

Figura A.1: Modelo de transistor bipolar incluyendo la fuente de corriente IC0, asociada a
corrientes parásitas en el dispositivo.

Analicemos el circuito de la figura A.1. Al modelo de transistor en activa se le ha
añadido una fuente de corriente IC0 que tiene en cuenta las corrientes parásitas que
circulan por el transistor. La nueva relación entre las corriente de colector y base se
obtiene de la siguiente manera:

I ′C = βI ′B
IC = I ′C + IC0

IB = I ′B − IC0 =
IC

β
− IC0(1 +

1

β
)

La ecuación de la malla que cubre la unión BE es:

VBB = IBRB + VBE + IERE

VBB =

(
IC

β
− IC0(1 +

1

β
)

)
(RB + RE) + VBE + ICRE

Las variables que son más sensibles a la temperatura en la ecuación anterior son IC e
IC0. Si se deriva la ecuación anterior con respecto a la temperatura se puede obtener la
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siguiente relación:

S =
∆IC

∆IC0

=
(RB + RE)(1 + β)

RB + RE(1 + β)

A esta relación la vamos a denominar factor de inestabilidad. Tiende hacia la unidad
cuando RE se aproxima a un circuito abierto. Toma el valor 1 + β cuando RE es un
cortocircuito.
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Apéndice B

MODIFICAR MODELOS DE
DISPOSITIVOS EN Spice.

Pasos para editar un modelo de dispositivo (PART ).

1. Trabajar con una hoja en blanco en Schematics .

2. Insertar un dispositivo existente de la libreŕıa.

3. Pulsar Edit → Model.

4. Pulsar en Edit instance model (text)

5. Cambiar los parámetros que se deseen, incluido el nombre del modelo.

6. Elegir la ruta donde guardar el fichero y guardar.

7. Opcionalmente, se puede cambiar el atributo COMPONENT si se desea.

Los cambios enumerados solo son aplicables a la hoja Schematics en uso. Si quiere usarse
el nuevo modelo en otra hoja es recomendable crear un subcircuito. Para ello se siguen
los mismos pasos de creación de subcircuitos.

Figura B.1: a) Subcircuito formado por un BJT pnp al que se le han modificado parámetros
del modelo original. b) Apariencia del subcircuito cuando se llama desde otra hoja Schematics.

1. Añadir conectores IF-IN en los terminales del dispositivo. A modo de ejemplo, si se
tratase de un transistor bipolar pnp, se añadiŕıan a los terminales de base, emisor y
colector (Fig. B.1). Se recomienda nombrar las etiquetas (b, c y e respectivamente).
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2. Guardar la hoja Schematics (Ej. Mimodelo00.sch).

3. Pulsar File → Symbolize → Save As (Enter name for current symbol): (Ej.
Mimodelo00 ).

4. Elegir la libreŕıa donde se guarda el subcircuito dentro del directorio UserLib. Choose
Library for Schematic Symbol: (Ej: MiLibreria.slb).

5. Para poder utilizar el modelo hay que activar la libreŕıa donde se ha guardado. Si se
tiene activada otra libreŕıa definida por el usuario distinta de la que se quiere usar
habrá que desactivarla previamente (limitaciones de la versión de estudiante). Para
evitar estos problemas se recomienda guardar los subcircuitos en la misma libreŕıa.
Para la activación de la libreŕıa se pulsa Options → Editor Configuraton → Library
Settings → Browse → MiLibreria.slb (Pulsar Abrir) → Add* → OK

6. Una vez realizados estos pasos se puede llamar al nuevo modelo: CRTL+G →
Mimodelo00
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